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1. Product Introduction
HQXS wildlife micro-tracker uses satellite positioning technology and dual-mode hybrid

positioning technology to obtain information such as latitude and longitude, speed, heading,

altitude, etc. At the same time, the device is equipped with a variety of sensors to collect other

corresponding data. All collected data is sent to the company's data center via GSM/4G/satellite

network, and the data can also be stored inside the tracker. The solar panel outside the device can

ensure the long-term power supply of the product, and the built-in lithium battery ensures that the

product can run normally when there is no sunlight. This product is independently developed by

our company and has completely independent intellectual property rights. It has ultra-small size,

ultra-low power consumption, and high-precision positioning characteristics.

2. Daily maintenance of products
 After purchasing this product, if it has not been used for more than one month, please put it

in the sun to charge for three days, and then charge it once a month regularly (charge in the sun for

three days).

 When installing this product, please contact our company two days in advance. The

technicians will set relevant parameters for your product to ensure that the product can be used

normally. Before installation, please place this product in an open and sunny place (such as an open

yard, roof of a house, etc.)

 Amagnetic switch controls the power switch mode of the tracker. The device is in shutdown

mode when the magnetic strip is attached to the product. When the magnetic stripe is removed, the

device will automatically turn on. The factory default is the shutdown state (with the magnetic strip

attached). Before releasing the species into the wild, please be sure to remove the magnetic stripe.

Otherwise, the device will not work properly.

 To ensure this product's standard and stable operation, the company provides complete

management services for each product.

 If you fail to implement the above items, it may cause the product not to be used normally,

and please be aware.
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3. The meaning and description of each indicator of the tracker
3.1 The meaning of the indicators of the tracker

No. Index Parameter Explanation

1 Time The time when the location point was collected (subject to Beijing
time)

2 Longitude GPS longitude, in degrees, accurate to five decimal places, using the
WGS-84 geodetic coordinate system

3 Latitude GPS latitude, in degrees, accurate to five decimal places, using the
WGS-84 geodetic coordinate system

4 Speed Km/h

5 Course The angle formed by the clockwise direction with the north direction
of 0°

6 Altitude The altitude with sea level as a reference, this parameter has reference
value only when GPS is 3D positioning mode

7 Temperature The temperature value collected by the device, in degrees Celsius

8 Voltage Device battery voltage

9 Exercise The number of activities in a collection period

10 Accuracy The accuracy of GPS positioning is divided into five grades: A, B, C,
D and E. See the table below for details.

11 HDOP Horizontal precision factor, reflecting the GPS positioning error, the
smaller the parameter, the higher the GPS positioning accuracy

12 VDOP Vertical precision factor
3.2 Description of positioning accuracy

(1) Overview of positioning accuracy

Positioning accuracy is the closeness between a spatial entity's location information (usually
coordinates) and its true location. Our company's products provide the original GPS positioning
accuracy factor data, and the equipment positioning accuracy adopts the linear regression analysis
method: Error=2.679243*HDOP+0.59144.

(2) Accuracy class and deviation

The Hunan Provincial Institute approves the HQXS satellite tracker of Quality Supervision and
Inspection of Products. The specific accuracy grades and deviations are as follows:

A B C D E

5 meters 10 meters 20 meters 100 meters 2000 meters

(3) Reliability of positioning accuracy

The positioning accuracy of the satellite tracker is 95% reliable.
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4. Parameters and Specifications
Model HQNT HQBV0702 HQBG0603 HQBG0803
Category backpack backpack backpack backpack

Weight 0.6～3 grams 2.2 grams 3 grams 3.2 grams

Height 5.5 mm 7 mm 7.5 mm 8 mm

Width 5 mm 12 mm 17 mm 14 mm

Length 6 mm 18 mm 21 mm 17 mm

Inner Diameter - - - -

Default Frequency 3 s 1 hour 1 hour 4 hours

Dense Tracking 1 s 1 minute 1 minute 1 minute

Data Storage Capacity - 5000 points 12000 points 12000 points

International Roaming - - support support

No Signal Processing - local storage local storage local storage

Positioning Method VHF
BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

Positioning Accuracy - 5 meters 5 meters 5 meters

Signal Transmission VHF VHF GSM
Cat-M1/

Cat-NB2

Antenna external external external external

Duration without Light

(built-in lithium battery) 15 days 15 days 6 days 5 days

Lifetime in the Wild

(average sunshine 2 hours) - >5 years >5 years >5 years

Waterproof Level IP68 IP68 IP67 IP68

Waterproof Depth 10 meters 10 meters 2 meters 10 meters

Operating Temperature -40~70℃ -40~70℃ -40~70℃ -40~70℃

Working Altitude <10000 meters <10000 meters <10000 meters <10000 meters

Low Battery Protection support support support support

Death Warning support support support support

Client Software
Windows

Android

Windows

Android

Windows

Android

Windows

Android
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Model HQBG0804 HQBG1206 HQBG2009P HQBG1310

Category backpack backpack backpack backpack

Weight 4.5 grams 6.5 grams 9 grams 10 grams

Height 9 mm 12 mm 16 mm 13 mm

Width 18 mm 20 mm 21 mm 19 mm

Length 22.5 mm 33 mm 35 mm 36 mm

Inner Diameter - - - -

Default Frequency 4 hours 3 hours 2 hours 2 hours

Dense Tracking 1 minute 1 minute 1 minute 1 minute

Data Storage Capacity 12000 points 12000 points 12000 points 12000 points

International Roaming support support support support

No Signal Processing local storage local storage local storage local storage

Positioning Method
BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

Positioning Accuracy 5 meters 5 meters 5 meters 5 meters

Signal Transmission GSM GSM GSM GSM

Antenna external external external external

Duration without Light

(built-in lithium battery) 7 days 10 days 7 days 12 days

Lifetime in the Wild

(average sunshine 2 hours) >5 years >5 years >5 years >5 years

Waterproof Level IP68 IP68 IP68 IP68

Waterproof Depth 10 meters 10 meters 10 meters 10 meters

Operating Temperature -40~70℃ -40~70℃ -40~70℃ -40~70℃

Working Altitude <10000 meters <10000 meters <10000 meters <10000 meters

Low Battery Protection support support support support

Death Warning support support support support

Client Software
Windows

Android

Windows

Android

Windows

Android

Windows

Android
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Model HQBG2210 HQBG1512S HQBG2512S HQBG1815S

Category backpack backpack backpack backpack

Weight 10 grams 13 grams 14 grams 15~18 grams

Height 22 mm 15 mm 25 mm 18 mm

Width 21 mm 21 mm 24 mm 23 mm

Length 47 mm 48 mm 48 mm 63 mm

Inner Diameter - - - -

Default Frequency 2 hours 1 hour 1 hour 1 hour

Dense Tracking 1 minute 1 minute 1 minute 1 minute

Data Storage Capacity 12000 points 12000 points 12000 points 12000 points

International Roaming support support support support

No Signal Processing local storage local storage local storage local storage

Positioning Method
BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

Positioning Accuracy 5 meters 5 meters 5 meters 5 meters

Signal Transmission GSM GSM GSM GSM

Antenna internal external internal internal

Duration without Light

(built-in lithium battery) 7 days 7 days 7 days 7 days

Lifetime in the Wild

(average sunshine 2 hours) >5 years >5 years >5 years >5 years

Waterproof Level IP68 IP68 IP68 IP68

Waterproof Depth 10 meters 10 meters 10 meters 10 meters

Operating

Temperature
-40~70℃ -40~70℃ -40~70℃ -40~70℃

Working Altitude <10000 meters <10000 meters <10000 meters <10000 meters

Low Battery Protection support support support support

Death Warning support support support support

Client Software
Windows

Android

Windows

Android

Windows

Android

Windows

Android
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Model HQBG2715L HQBG3621L HQBG2830L HQBG5037L

Category backpack backpack backpack backpack

Weight 17 grams 23~29 grams 27 grams 50~65 grams

Height 24mm 35mm 28mm 44mm

Width 24mm 24mm 27mm 39mm

Length 58mm 70mm 63mm 98mm

Inner Diameter - - - -

Default Frequency 1 hour 1 hour 1 hour 1 hour

Dense Tracking 1 minute 1 minute 1 minute 1 minute

Data Storage Capacity 12000 points 12000 points 12000 points 12000 points

International Roaming support support support support

No Signal Processing local storage local storage local storage local storage

Positioning Method
BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

Positioning Accuracy 5 meters 5 meters 5 meters 5 meters

Signal Transmission GSM GSM GSM GSM

Antenna internal internal external internal

Duration without Light

(built-in lithium

battery) 7 days 15 days 30 days 30 days

Lifetime in the Wild (average

sunshine 2

hours) >5 years >5 years >5 years >5 years

Waterproof Level IP68 IP68 IP68 IP68

Waterproof Depth 10 meters 10 meters 10 meters 10 meters

Operating Temperature -40~70℃ -40~70℃ -40~70℃ -40~70℃

Working Altitude <10000 meters <10000 meters <10000 meters <10000 meters

Low Battery Protection support support support support

Death Warning support support support support

Client Software
Windows

Android

Windows

Android

Windows

Android

Windows

Android
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Model HQLG4037S HQNG4625P HQAN40L HQAN40M

Category leg ring neck ring neck ring neck ring

Weight 37~44 grams 34~75 grams 600~800 grams 400~600 grams

Height - - - -

Width - 32mm 50mm 32mm

Length 51mm 40~80mm - -

Inner Diameter 18~24mm 30~60mm customize customize

Default Frequency 1 hour 1 hour 1 hour 1 hour

Dense Tracking 1 minute 1 minute 1 minute 1 minute

Data Storage Capacity 12000 points 12000 points 12000 points 12000 points

International Roaming support support support support

No Signal Processing local storage local storage local storage local storage

Positioning Method
BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

Positioning Accuracy 5 meters 5 meters 5 meters 5 meters

Signal Transmission GSM GSM GSM GSM

Antenna internal internal internal internal

Duration without Light

(built-in lithium battery) 7 days 15 days 1000 days 800 days

Lifetime in the Wild

(average sunshine 2 hours) >5 years >5 years >5 years >5 years

Waterproof Level IP68 IP68 IP68 IP68

Waterproof Depth 10 meters 10 meters 10 meters 10 meters

Operating Temperature -40~70℃ -40~70℃ -40~70℃ -40~70℃

Working Altitude <10000 meters <10000 meters <10000 meters <10000 meters

Low Battery Protection support support support support

Death Warning support support support support

Client Software
Windows

Android

Windows

Android

Windows

Android

Windows

Android
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Model HQAN40S HQAI-L HQAI-M HQAI-S

Category collar collar collar collar

Weight 100~300 grams 800~1600 grams 350~700 grams 100~300 grams

Height - - - -

Width 22mm 50mm 44mm 22mm

Length - - - -

Inner Diameter customize customize customize customize

Default Frequency 1 hour 1 hour 1 hour 1 hour

Dense Tracking 1 minute 1 minute 1 minute 1 minute

Data Storage Capacity 12000 points 12000 points 12000 points 12000 points

International Roaming support support support support

No Signal Processing local storage local storage local storage local storage

Positioning Method
BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

Positioning Accuracy 5 meters 5 meters 5 meters 5 meters

Signal Transmission GSM GSM/iridium GSM/iridium GSM/iridium

Antenna internal internal internal internal

Duration without Light

(built-in lithium battery) 365 days 900 days 700 days 200 days

Lifetime in the Wild

(average sunshine 2 hours) >5 years >5 years >5 years >5 years

Waterproof Level IP68 IP68 IP68 IP68

Waterproof Depth 10 meters 10 meters 10 meters 10 meters

Operating Temperature -40~70℃ -40~70℃ -40~70℃ -40~70℃

Working Altitude <10000 meters <10000 meters <10000 meters <10000 meters

Low Battery Protection support support support support

Death Warning support support support support

Client Software
Windows

Android

Windows

Android

Windows

Android

Windows

Android
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Model HQAB-L HQAB-M HQAN40MC HQZN

Category collar collar collar customize

Weight 1000~1600 grams 500~1000 grams 500~1000 grams customize

Height - - - customize

Width 50mm 44mm 44mm customize

Length - - - customize

Inner Diameter customize customize customize customize

Default Frequency 1 hour 1 hour 1 hour ＞1 s

Dense Tracking 1 minute 1 minute 1 minute ＞1 s

Data Storage Capacity 12000 points 12000 points 6 million points customize

International Roaming support support support support

No Signal Processing local storage local storage local storage local storage

Positioning Method
BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

BDS/GPS/

GLONASS

Positioning Accuracy 5 meters 5 meters 5 meters 5 meters

Signal Transmission

GSM/

Beidou short message

GSM/

Beidou short message 4G/iridium GSM/BDS/iridium

Antenna internal internal internal customize

Duration without Light

(built-in lithium battery) 800 days 800 days 800 days customize

Lifetime in the Wild

(average sunshine 2

hours) >5 years >5 years >5 years >5 years

Waterproof Level IP68 IP68 IP68 IP68

Waterproof Depth 10 meters 10 meters 10 meters 10 meters

Operating

Temperature
-40~70℃ -40~70℃ -40~70℃ -40~70℃

Working Altitude <10000 meters <10000 meters <10000 meters <10000 meters

Low Battery Protection support support support support

Death Warning support support support support

Client Software
Windows

Android

Windows

Android

Windows

Android

Windows

Android
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Start-up Test and Debugging
 Unpacking inspection

After receiving the product, please check whether the appearance is in good condition and whether

the installation accessories are complete (see the list of accessories). If you have any questions,

please contact our company in time.

 Installation

（1） Start the Product

When installing this product, please contact our company two days in advance, and the technicians

will set relevant parameters for your product to ensure that the product can be used normally.

（2） Product Registration

Please note the product number and study species number when installing the product. After

installing the product, please contact our company in time, and submit the installation information to

the engineer so that the technician can bind the product and the species for you in the background

and provide better service.

 Product Management

When the product is turned on, if it is not used for a short period, please notify the company to turn

it off in time to maintain the power of the product and avoid extra communication charges.

Software Operation Process and Use Method
1.1. Software Installation
(1) Quickly Understand

 The operating systems are WindowsXP,Windows7 (32-bit/64-bit), and Windows8.

 Operating environment: .NET Framework 4.5.2.

 Installation time: If your computer has .net Framework 4.5.2 installed, it only takes 30

seconds to complete the installation.

(2) Installation steps
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Step 1: Open the installation folder, run Setup.exe, and start the program installation. Figure 1:

Figure 1

Step 2: If the computer does not have the .net Framework 4.5.2 environment installed, it will

automatically start to install the .net Framework 4.5.2, as shown in Figure 2. (If the computer has

already installed .net Framework 4.5.2 or above, go directly to the fourth step, as shown in Figure 4.)

Figure 2

Step 3: Select "Install" to start the automatic installation of .net Framework 4.5.2, about 2-3 minutes,

as shown in Figure 3.
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Figure 3

Step 4: After the installation of .net Framework 4.5.2 is completed, enter the "InstallShield Wizard

for HQXS Tracker Information Service Platform", as shown in Figure 4.

Figure 4

Step 5: Select "Next" to start the installation, as shown in Figure 5.
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Figure 5

Step 6: Click "Finish" to complete the installation, as shown in Figure 6.

Step 7: The desktop will generate a shortcut icon of "Global Messenger", as shown in Figure 7.

Figure 6 Figure 7
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Global Messenger Tracker Data Service Platform (V3.1)

User's Manual

1. Introduction to the platform

Global Messenger Tracking Data Service Platform V3.1 is a wildlife tracking platform from Hunan

Global Messenger Technology. The system is based on GIS technology and incorporates knowledge

of animal ecology. It has functions such as device management and remote control, historical track

data retrieval, animal behaviour analysis, map services, track visualization, data import and export,

camera photo and video management.

2. Accounts and permissions

Hunan Global Messenger Technology provides the platform account. (hereafter "Company"). The

account is divided into two types: master account and general account. If you don't have an account,

you can only login as a guest.

Fig. 1 Login

2.1. Language and site settings
The software language and the access site's location can be set as required.
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Fig. 2 Setup

2. 2. Master account
The master account has permissions for project management, equipment changes, remote control,

data export, offline packet generation, etc. The team leader or supervisor usually uses the master

account, and only one master account is assigned to a research team.

2.3. General account
The general account could view data from the authorised equipment, data export and offline data

generation functions available upon application. The data query period and fields for general

accounts can also be restricted by request. The general account is usually used by sub-project leaders,

team researchers or students.

Fig. 3 System interface 1
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Fig. 4 System interface 2

2.4. Visitors
Visitors can directly access the platform without an account and password. Visitor accounts cannot

query data online and can only access offline track data, including offline projects, offline track data

package data and external GIS files.

Fig. 5 Visitor account interface

2.5. Account information maintenance
Click on the account information in [File] to change your account name, phone number, email

address and login password and to view your current account permissions.
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Fig. 6 Account information maintenance

3. Tracker management

3.1. List of trackers
The list is divided into three levels: customer, project and tracker. The number after the customer's

name is the total number of devices.

The first number after the project name is the number of active devices in the last seven days, and

the second is the total number of devices under the project.

Fig. 7 List of devices

Total number of equipment

Total equipment number
of the projectNumber of active devices

in the past 1 week
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Find a tracker: Enter the device name, hardware number and other information in the search box to

quickly find a device and support fuzzy queries.

Fig. 8 Device search

Check the latest location: right click menu on [Device List], [Project], [Tracker]

Select "Last position" in the map to display the latest location of the tracker on the map.

Fig. 9 Final position of the equipment

3.2. Project management
New project: The master account can create a new project, modify project names and manage the

subordination of projects to trackers by dragging the mouse.

Deleting items: The master account can delete a project that does not contain trackers.
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3.3. Tracker management
Rename trackers: accounts with a permit can change the tracker's name.

Mover trackers: The master account can move a tracker to a different project.

Remote control: In the tracker list, select a tracker and click remote control of the data collection

time and transmission time in the right-click menu. Collection time can be set to collect every hour

or can be customised. The battery and the last transmission time can also be viewed here. Data

transmission time can be modified according to the number of fixes (recorded locations).

Modifications can be viewed in the command window.

Fig. 10 Remote command menu

Fig. 11 Remote command modification screen

Fig. 12 Command window interface

Tracker Properties: View details of the tracked device, including hardware number, project, device

model, device status, battery, last transmission time, data expiry date, installation time, installation

location and other information.
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Fig. 13 Tracker details

Tracker Information Table: Select [Tracker Information Window] in the [Window] menu to

display the details of all trackers under the current account, which can be exported as an Excel sheet.

Fig. 14 Device information window
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4. Track data query

4.1. quick track search
In the tracker list, select a tracker and select 'View all tracks' in the right-click menu or double-click

on the tracker to query all tracks for this device and display the tracks on the map.

Fig. 15 View all tracks for a single device

4.2. Searching for tracks by condition
Check the device to be queried in the tracker list. It is possible to search the track of multiple devices

by recent [days] and [time period], and you can also attach more search conditions, such as speed,

altitude, accuracy level and time.

Fig. 16 Searching for tracks by condition

Note: Different tracker models have different track data fields, e.g., dual channel trackers have a

signal source field; high accuracy activity sensor devices have activity 1, activity 2 and activity 3

fields; trackers with bathymetry sensor have a bathymetry field; trackers with gyroscope sensor

record data from X, Y and Z axis, respectively.
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4.3. Invalid data handling
When some fixes need to be filtered, they can be selected as "invalid data", which will be screened

out during track generation and statistical analysis. (note: this operation is not reversible)

Fig. 17 Invalid data handling

5. Track visualisation

5.1. Track visualisation
The track data table window selects "2D Track" from the right-click menu to generate 2D tracks

from the selected row or all rows.

Fig. 18 Track generation menu
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Fig. 19 2D Track map interface

5.2. Data export
In the track data table window, select "Export Excel file", "Export .Shp file", and "Export .Kml file"

from the right-click menu to export the currently selected rows. Data can be exported to

Excel/CSV, .Shape and Kml format. The geographic coordinate system is WGS84.

6. Map options

6.1. Online map options
There are four online maps available: Sky Maps, ESRI Maps, Open Street Maps and Google Maps,

with various modes such as vector maps, satellite maps, hybrid maps and topographic maps. The

map coordinate system is Web Mercator projection coordinates.

6.2. Browse the map
• Panning: press and hold the left mouse button to move the map.

• Zoom in: zoom in on the map.

• Zoom out: zoom out on the map.

• Zoom to all: Zoom the map to the geometric range of all fixes.

• Zoom to selection fixes: Zoom the map to the geometric range of the selected fixes.

• Previous View: Switch the map view to the previous view.

• Next View: Switch the map view to the next view.
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6.3. Selection function
• Rectangular selection: draw a rectangle on the map to select fixes.

• Polygon selection: draw a polygon on the map to select fixes.

• Circle selection: draw a circle on the map to select fixes.

• Save selected fixes: select fixes or tracks and save them as a vector layer, as shown below.

Fig. 20 Save vector data as a layer

6.4. Information query
The "Information Query" tool queries the map window for information about the properties of a

graphic object. Click on the "Previous" and "Next" buttons in the information box to browse the

adjacent objects in the same layer and choose whether to centre the selected object; click anywhere

to query the address information.

Fig. 21 Graphical information query
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Address information is available on the Web Map, which can be turned off on the Web Map layer

node

Fig. 22 Address information search

6.5. measuring tools
The multi-point distance and area measurements can be performed by mouse clicks in the map

window.

Fig. 23 Measuring distances

6.6. Map options
Settings for map background colour, coordinate format, meridian offset degrees, and sky map

permissions.
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Fig. 24 Map options settings screen

6.7. Map export
Users with data download permissions can export the contents of the current map window as an

image. The guide is available in both standard and HD formats.

Standard format: After setting the image format, image quality and export path of the exported

image, the current map content is directly exported as an image.

HD format: box the area to be exported on the map, set the export map level and click [Cache

Tile].When the tile cache is complete, click the [Export Image] button to generate HD pictures.

Fig .25 Map export interface

7. Layer management

The layer manager is divided into projects, layer groups and layers. Layer groups can contain

multiple layers or groups of layers. The layer types are point, line, surface, vector, raster, image and

web map layers.
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Project

Layer

Fig. 26 Layer management

7.1. Project operations
The project node corresponds to the current map framework. It enables adding local map layers,

Spatialite database layers, Wms layers, creating new layer groups, importing offline data packages,

emptying map data, etc. Create new layer groups, import offline data packs, clear map data and

more.

Fig. 27 Project node menu

Add layers: add local spatial data to the map, support vector, raster and image data, and the

coordinate system of the imported data is automatically converted to the current map coordinates.

Add Spatialite layer: reads spatial data from the SQLite database and adds it to the map.

Add Wms layer: Get a WMS layer via a network request and add it to the map.

New layer group: Create a new layer group in the project.

Layer group
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Import offline data pack: Import offline data pack from outside to the map, and the coordinate

system of the imported data is automatically converted to the current map coordinates. The offline

layer group format is 2D Data group file (*.dg2), and accounts with data download permission can

export track data as an offline data pack to share with others.

Clear: removes all data from the map. This operation does not delete the source data.

All selectable: Batch sets whether all vector layers in the map are selectable or not.

Zoom to all: Zooms the map to the maximum visible area, including all objects.

Properties: View coordinate information for the map frame.

7.2. Layer group operations

Fig. 28 Layer group node menu

Adding layers: as above.

Adding the Spatialite layer: as above.

Add Wms layer: as above.

Export offline data pack: Users with data download permission can export the currently selected

layer group as an offline data pack file (2D Data group file *.dg2).

Delete: Deletes the currently selected layer group and all sub-layer groups and layers below the

layer group; this operation does not delete the source data.

Separate control over the display of track points, track lines and point numbers: if the layer

group type is a system-generated 'track layer group', the visibility of track points, track lines and

track point numbers can be controlled separately.

Selectable All: Batch sets whether all vector layers in a layer group are selectable.
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Zoom to all: zooms the map to the geometric extent of all objects in the selected layer group.

Properties: View coordinate information for the selected layer group, with the same coordinate

system for all layers in the layer group.

Batch Modification: Batch personalisation of track points, lines, and numbers.

Fig. 29 Batch setting style screen

Fig. 30 Dot and line symbol setting interface

7.3. Layer manipulation

Fig. 31 Layer node menu
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Open property sheet: view all property data for the selected layer.

Fig. 32 Property sheet window

Export shape data: Users with data download permission can export the currently selected layer as

an offline data file in a Shapefile format (*.shp), which supports coordinate conversion.

Fig. 33 Interface for exporting shape file data

Export kml data: Users with data download permission can export the currently selected layer as

an offline data file in the format of a kml file.

Export property sheet: Users with data download permission can export the property sheet of the

currently selected layer to an excel file.

Delete layer: removes the specified layer from the current layer group. This operation does not

delete the data source file.

Selectable: Set whether the objects in the vector layer are selectable. After setting selectable, you

can view the layer object information.

Create a heat map: select the point layer to create a heat map, and the gradient colour can be

personalized.
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Fig. 34 Heat map interface

High-Quality Rendering: When High-Quality Rendering mode is on, richer point symbols and line

patterns can be set, but the graphics rendering speed is reduced.

Automatic annotation: show or hide the numbering of fixes.

Zoom to layer: Zoom the map to the maximum extent of the current layer.

Properties: view the spatial extent of layers, number of shapes, coordinate information, etc.

8. Track statistics and analysis

The platform analyses the trend of each variable over time. Select "Statistics" in the [Track Query

Window] to open the data statistics window.

8.1. Time series statistics
Time series analysis can be performed on attributes such as longitude, latitude, altitude, speed and

temperature of the track data.
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Fig. 35 Time series analysis

8.2. Aggregate statistics
The track data's attributes, such as longitude, latitude, altitude, speed and temperature, can be

analysed by time.

Fig. 36 Aggregate statistics interface

Fig. 37 Time-aggregate statistics

8.3. Accuracy ratio statistics
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The number and percentage of fixes with different positioning accuracy levels can be scaled for

track data, as shown in the figure below.

Fig. 38 Data Accuracy-Grade Statistics

9. Home Range Computing

The platform has a species home range calculation function. Select the track layer, click [Home

range calculation] in the main menu and select the minimum

Minimum Convex polygons (MCP) or kernel density estimates (KDE) can be calculated.

Fig. 39 Home Domain Calculation

9.1. Minimum convex polygon (MCP) calculation
Select a layer with tracks or group of layers, select a time field as required, and carry out home

domain analysis calculations for single or all individuals via the least convex polygon algorithm,

generating a resultant line layer and surface layer on the map with attributes containing information

such as percentage of selection, area etc.
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Fig. 40 Minimum convex polygon setting interface

Fig. 41 Minimum Convex Polygon (MCP) calculation model

9.2. Kernel Density Estimation (KDE) calculations
Select a layer with tracks or a group of layers, select a time field and set the kernel method, raster

parameters and bandwidth (kernel smoothing). Home range calculations for single or all individuals

by a density estimation algorithm generate documentation of the calculation process and results.



Hunan Global Messenger Technology Co., Ltd
Room 1004, Building B2,Huanchuang Enterprise Plaza,2450 Yuelu West Avenue, High-tech Zone, Changsha City, Hunan, China
Tel: 0086-0731-85568037

35

Fig. 42 Nuclear density setting screen

Fig. 43 Kernel Density (KDE) calculation model

Note: Raster symbol and line can be customised.
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Fig. 44 Kernel Density (KDE) style settings

10. High-frequency activity queries

Check the trackers in the list, and query the activity data of multiple devices by [days] and [time

period].

Fig. 45 Active devices query window

11. Camera data query

11.1. Photo video points
Photo & Video Layer Loading: Select [Photo & Video] in the toolbar of the map window, check

the device in the pop-up dialogue box and set the time slot to present the pictures and videos taken

by the tracker camera will be given as points on the map.
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Fig. 46 Photo and video search interface

View photos and videos: Select [View photos and videos] in the toolbar of the map window to

activate the viewing function. Clicking on photo and video points in the map will automatically

associate them with the playback of photos and videos.

Fig. 47 View video
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Fig. 48 View photos

11.2. Photo video management
Select [Photo & Video Window] in the [Window] menu to manage all photos and videos taken by

the tracker camera, providing "batch download" and playback functions.

Fig. 49 Photo and video management window
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12. Point-of-interest management
12.1. New points of interest
Select [Add Point of Interest] in the toolbar of the map window to choose the point of interest on the

map. Add relevant attribute information and image data to the point of interest.

Fig. 50 New points of interest

12.2. Editing points of interest
Select [Edit Point of Interest] in the toolbar of the map window to re-edit the attribute information

and picture data of the point of interest in the map window.

12.3. Point of interest management
The [Window] menu opens the interest point management window, where users can view all the

points of interest under their account and make changes to

Points of interest can be edited, deleted, displayed and refreshed, and points of interest can also be

generated and displayed on the map.

Fig. 51 Point of interest management
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Fig. 52 Showing points of interest in the map

Data descriptions are available in the "Help" menu to view the system's criteria for each data item.

13. Global tracking mobile phone APP

Based on the mobile Internet thinking, the "Global" Tracking mobile APP is developed to

synchronize remote server data services in real-time. The APP mainly includes five functions:field

installation assistant, device location attention, track view, point of the interest collection and "find

it".

Field installation assistant: by scanning the QR code, you can quickly obtain the hardware

information of the tracker, support custom names and on-site photos, and facilitate customer

management and maintenance of equipment information.

Attention device: After setting the attention device, the service background can automatically push

the position dynamic of the device, and the abnormal low voltage warning information, so that users

can understand the device and species status in real-time.

Location and track view: it can view the distribution of all devices, view the latest location and

movement track of the specified equipment, view the detailed information of any site, etc., and can
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share the location information with colleagues and friends through Wechat, QQ, SMS and other

ways.

POI collection: users can add places of interest to favourites, and can be associated with photos and

other media.

Find it:display the location,speed and other information of the target individuals and the current

users in real-time, and automatically calculate the distance and orientation between the two, so as to

provide help for tracking and searching for individuals in the field.

14. Precautions

Thank you for purchasing our product. To better use this product, please read this manual carefully

before using it. This product specification is designed to guide you about the functions and

characteristics of our products:

The description of this manual is based on the default settings of the HQ Series tracker.

Please keep this instruction properly for future reference.

Copyright and Disclaime (please see below)r:

Hunan Global Letter Technology Co., Ltd. All rights and rights reserved.

The contents of this product specification are updated irregularly without advance notice.

This product specification cannot be copied, disseminated or reproduced for any purpose, including

photocopy and voice and video form, without the authorization of the Company.

In no event shall the company be liable for any direct, indirect, punitive, incidental, incidental,

special, accidental loss or any kind arising out of improper use.

For more updates, please visit the company website http://en.hqxs.net/.

http://en.hqxs.net/
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